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1 INTRODUCTION – DISPLAY DIRECTOR 

1.1 Description 
The Display Director (DD) is the main program to interact with the matrix board. From here 
you collect all the information about images to send on the board and how they have to be 
sent. The DD interacts with almost all programs of the Omega Matrix Board Software. 
 
To invoke the Display Director, select it from the Swiss Timing Group, and press <OK> or 
simply click left mouse button on its name as can be seen it on.  

1.2 Definitions 
Here are some definitions used within the Display Director:  
 
An Image is a bitmap made by the editors or coming from a sport event. It is "what you 
see on the board", it may cover the whole board or only part of it. 
 
For the definition of a Reference Format (RF), see the WFED chapter. 
 
An Effect is an attribute set to a rectangle. It determines how the image contained in that 
rectangle is displayed on the board. Examples of effects: scroll, diaphragm, animation... 
An effect may itself have some attributes (or parameters) such as its speed, direction, 
duration, etc... 
 
A Frame is an attribute that can be set to a rectangle. When set, the image contained in 
that rectangle will be sent to the board with a border. A frame also has some attributes (or 
parameters) such as color, dimension, etc... 
 
A Format is a group of one or more windows which may 
contain an image with an effect and a frame. It is built upon 
an RF where images may be assigned to the rectangles of 
that RF. A format is given a name and stored on the disk. 
For example, a format "Soccer" could be built upon the RF 
"Half" (see Figure 1), where the left rectangle is assigned to 
the image "Whistle.bmp" sent with a diaphragm open, and 
the right rectangle is assigned to the image "Score" of 
football program sent with the Static effect and with a white 
frame of size 3. 
 
A Sequence is a list of successive DD commands that are stored with the Recorder. A 
sequence is given a name and may be stored on the disk to be recalled (=load and play) 
later. 

HALF
Fig. 1 
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A sequence could, for example, look like this:  
 

1. Clear the Board.  
2.  Get RF "FULL".  
3.  Get Image "Welcome.bmp".  
4.  Set Effect "Scroll Left".  
5.  Execute. 

1.3 The DD Working Space 
On figure 2, you can see the Display Director Working Space. 
 

 
Fig. 2 

 
The Display Director appears in an ordinary window with title bar, menu bar and tools bar. 
The menu bar contains various DD commands (see later in this chapter). As you can see 
on the figure, there are the following sections in the window's client area: 
 
The View Online window, containing the Swiss Timing logo, is the window that contains 
the image currently on the matrix board. It is the user's feedback when he has sent 
something to the board. This window is created when connecting the remote display 
controller (see "Getting Started" later in this chapter). Users cannot interact with the View 
window as their content is refreshed automatically by the system. You can only do a zoom 
by selecting Zoom command in contextual menu of this window (To obtain contextual 
menu, you just have to press right button when the mouse pointer is on the window). 
 
Next to the View Window, is the Preview window containing an RF where images 
(OMEGA symbol, photo or video) have been assigned to some rectangles. The Preview is 
the user's feedback on the work he is currently doing. Note that in the Preview the RF's 
rectangles are identified, as they have been created by the WFED, by a system-given 
number. 
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Above the View Online window, is the Window Control Bar (= WCB). This bar is the main 
working area of the DD. You can drag it off the main window (Figure 3) and reduce it 
(Figure 4). However it is recommended to let this tool bar fixed on the top of the DD 
program as well as other tool bar. 
 

 
 Fig. 3 

 

 
Fig. 4 

 
 
Window hierarchy is displayed in the tree window. Its function is the same as in the 
WFED. The current selected window is displayed with a check ( ). 
 
On the right side of the screen is the Recorder Remote Control Window, used when 
recording or playing a sequence. 

1.4 Getting Started With The DD 
First ensure that the board is switched on and that the link between the computer and the 
board distribution box has been correctly established. 
 
The Display Director program first performs its startup initialization procedures.   
 
When initialization has been completed, the DD window appears on your screen. At start, 
it contains a cleared Preview window and an empty WCB. 
 
In order to send images, the Display Director needs to connect to a Remote Display 
Controller. This is a background program managing images and sending data. Select 
Connect from the Options pull-down menu. 
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1.5 Sending Images And Working With the WCB 

1.5.1 Selecting an RF 

As seen before, an image must be set to a rectangle of an RF before it can be sent to the 
board. To do so, select Open from the Ref Formats menu bar. This causes a list box of 
available RFs to open. Double-click on the required RF or select it with the arrow keys and 
press <OK>. This removes the list box and activates the RF in the Preview. 
 
An alternate way to get an RF is to activate the contextual menu of Preview Window and 
selecting Open reference format.  
 

Or a third alternate way to get an RF is to press  in standard toolbar.  
 
If there are no available RFs, you should create some with the WFED. Invoke the WFED 
(at that time, the DD window may still be opened or minimized on your screen) and 
proceed as described in WFED chapter. Once your RF(s) is (are) created and saved on 
disk, re-activate again the DD window and select Refresh from the Ref Formats pull-down. 
This causes the RFs to be called into the list box contents to be refreshed. 
 
Activating an RF implies following changes on the DD screen: 
 
• The Tree displays the selected RF in a hierarchical order. A Tree element is identified 

by a unique number, its identifier, given by the system. Areas appear with a gray 
square, windows with a green square and superimposed windows with a red square 
(for definitions of these items, see the WFED chapter). 

 
• The WCB finally displays, at left of its window, the size and position of the active 

rectangle of the RF. Note that only one rectangle of a RF may be active at a time. 

1.5.2 Activating a Rectangle 

To get an image into a rectangle of an RF, the rectangle must be active. When selecting 
an RF with several rectangles, the first rectangle that is not an Area is active by default. 
This implies that its coordinates are displayed in the WCB (these coordinates cannot be 
updated, they only have an informal purpose). 
 
To activate another rectangle, following operations can be done: 
(In this example, it is assumed the current RF contains more than one rectangle !) 
 
 Using the mouse: 
 

1. Click with left mouse button inside the required rectangle in the Preview; 
2. Click with left mouse button on the rectangle identifier of the tree. 
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1.5.3 Effect command toggle on a Rectangle 

Click with the middle mouse button inside the required rectangle in the Preview or the tree; 
the corresponding effect, for this rectangle will change to NONE, and the rectangle 
disappears from the board. 
Clicking again with the middle mouse button will restore the defined effect and play it 
directly on the board. 
 
This function is useful to quickly display, then remove a superimposed window with some 
temporary information (for example the running time). 

1.5.4 Getting an Image into a Rectangle 

To be able to receive an image, a rectangle needs to be active. Thereafter, inserting an 
image into a rectangle can occur in following manner: 
 
Select Get from Disk from the Images pull-down menu ( or press <CTRL>+i ) to retrieve 
an image from your hard disk (or alternately from a diskette). Valid images are the ones 
made by both the Graphic Editor (Paint Shop Pro i.e.) and the Text Editor. You can also 

press  in the WCB. 
 
The command Get from Disk is also available in the Preview contextual menu. 
 
Those commands display the Open dialog. 
 
The Current Directory will be the first directory specified in the Images Path (see Default 
Directories Entries, later in this chapter). 
 
Selecting an image and confirming with the "Open" pushbutton removes the dialog and 
gets the image into the current rectangle. If an attempt was made to open a file that has no 
image in, the system displays a warning and interrupts the open operation. Otherwise, the 
image appears in the Preview window. 
 
An alternate way to get an image is to select one of the dropdown combo box Image in the 
WCB. This combo box allows user to select images from default image path. 
   
Select Get from Maker to request an image created by a background program. A maker 
can be, for instance, a program running on the computer and receiving data from an 
external device such as a sport system. It creates and updates one or more images 
according to the data received by a serial line. 
 
This causes a dialog like the one on figure 5 to be activated. Here, it is possible to select 
both the maker and its related image. 
 
Note that the makers displayed in the list are only the ones which have been started. 
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Press <OK> to validate your selection or <Cancel> to abort 
the operation. 
 
The Get from Maker command is also available in the 
contextual menu of the Preview window.  
There is a special feature to know all makers installed on your 
computer, just write "ALL" in Image entryfield. 
  
 
 Notes for the image selection: 
 
• In case no rectangle of an RF is selected in the Preview window, a warning message 

displays and no image selection is possible. 
 
• It is the user's responsibility to ensure that the rectangle is long enough to contain the 

required image. If not, part of the image will be lost. 
 
• The image file name may be entered directly in the WCB file name entryfield. Note 

that the first letter of a maker image is always a '@'. 
 

 
Fig. 6 

 
On figure 6, the file name entryfield contains OMEGAOFTK.BMP which is the image 
currently in rectangle 2. When searching for an image, the DD first scans through the 
current directory and then through an images path, if one is specified. This path is said to 
be the default images path and it is built on one or more user-given directories.  
 
To create, view or modify this path, select 
Paths from the Defaults pull-down menu. 
This causes a dialog to open as shown on 
figure 7. 
 
The current image paths are displayed in 
the list box. One or more directories may be 
given to prompt the system to scan them for 
images.  
 
The scan priority order could be changed 
using up or down arrow. 
 

 
Fig. 5 

Fig. 7 
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To apply modifications to this default, proceed as follows:  
 

1. Press Add to add a new path or select a path in list box if you want to modify it.  
2. Press Remove or Modify as required. 
3. Press <OK> to validate the change. 

 
So, to invoke an image from the WCB filename entryfield, Drop down the Image combo 
box in WCB file name entryfield. This causes the system to scan through all default 
directories (Fig. 7) and it displays all compatible image files. Select an image and then it 
will be displayed in the Preview window.  
To request an image from a directory that does not belong to the image paths, simply 

press  in the WCB. 
 
It might happen that two files have the same file name but are located in different 
directories, both belonging to the images path. In this case, the first directory (= "the 
topmost inside the list box") will be taken into consideration. 
 
To quickly clear the filename entryfield if the WCB already has got the focus, delete 
filename: it will remove any previous loaded image. This also causes the current rectangle 
to be cleared in the Preview window. 
 
If the WCB filename entryfield has got the focus, use the arrow keys to quickly select an 
image. 
 
Note: when you get an image into an RF's rectangle, it causes the Effect Combo Box, 
located at the right side of the WCB file name entryfield, to select a default effect, and 
depending on the kind of image requested (effects and other rectangle attributes are 
described later in this chapter). 

1.5.5 Positioning Images inside a Rectangle 
 
Once an image has been requested into the Preview window, the display director may 
position it as required, before sending it onto the board. Use the following keypad keys to 
move the image inside the rectangle: 
 
 7 (or Home)  sets the image to the top left corner. 

 8 (or )  moves the image one pixel upwards. 

 9 (or PgUp)  sets the image to the top right corner. 

 4 (or )  moves the image one pixel to the left. 

 5   centers the image inside the rectangle. 

 6 (or )  moves the image one pixel to the right. 

 1 (or End)  sets the image to the bottom left corner. 

 2 (or )  moves the image one pixel downwards. 

 3 (or PgDn)  sets the image to the bottom right corner. 
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Fig. 8 

If the image outgrows the size of the rectangle, following additional functions are provided: 

 <CTRL>+<PgUp> scrolls the image one page up. 
 <CTRL>+<PgDn> scrolls the image one page down. 

<CTRL>+<5> sets the image according to the position of the rectangle to 
which it is assigned to. Example: if the rectangle is on the 
bottom of the Preview, the bottom of the image is shown. 

 
An image can be stretched to fit the rectangle where it has 
been placed. Use the stretch button  to do this. Warning, 
this is a non-proportional stretch which means that if the 
image is not proportional to the board size, the image 
should appear with distortion.  
 

1.5.6 Sending Images: the Commands menu 
 
When images are ready, you have to issue a command that sends them effectively to the 
board. To do so, the connection with the remote display controller must be effective 
otherwise no images can be sent. 
 
On figure 9, the Commands pull-down menu is 
displayed. Issue Execute from this pull-down menu 
(or Keypad plus) to send one or more images to the 
board. Note that this command effectively sends the 
changes made to the Preview window. We strongly 
recommend you to use the '+' key of the keypad, it's 
definitely the fastest way to send data to scoreboard.  
If no changes were made since the last Execute, only 
the actual Activated Rectangle is sent. 
 
If you want to force all the rectangles to be refreshed, issue Execute All (or press 
<Shift>+Keypad plus). This causes each image in each rectangle to be re-transmitted with 
all their attributes (frame, effect, background; see description later in this chapter). 
 
The Clear command (or Keypad minus) sends an empty image to clear the whole board. If 
effects are still in progress, users are prompted to validate the clear operation. 
 
The Effects Pause command (or "Pause" key) toggle stops sending images to the board. 
If the stop is enabled, a stop icon is showed in the View window. Pressing again the 
"Pause" key lets the images be transmitted again; this function is useful when, for 
example, we are showing a speech with the Float effect, and we try to follow the orator 
reading the talk. If, for some reason, he stops reading, we can temporarily halt the effect 
with the Pause function, and restart it when he continues to read. 
 
Note that sending a rectangle to the board (with the "Execute" or "Execute All" Command) 
does not alter in any way the work you are currently doing in the WCB. This means the 
current rectangle, with its contents, remains active in the WCB, and the RF with the 
images are visible in the Preview window. 

Fig. 9 
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1.5.7 Setting Attributes to Rectangles 

Often, the way an image is sent onto the board is 
nearly as important as the image itself. This is why the 
DD provides some attributes to emphasize images.  
 
Effects are the most common attributes set to images. 
Actually, effects are set to rectangles more than to 
images, because an image itself does not change, it is 
only the way it arrives at the board that is different. 
This attribute is set in the WCB using the Effect 
Combo Box (See figure 10). 
 
An effect is set before sending a rectangle on the board. Again, only the active rectangle 
may receive an effect. To select one, press left mouse button on the combo box arrow. 
This causes the combo box to open and list the available effects. Clicking on one of them 
sets this one active (or makes it become the current effect) and closes the combo box. An 
alternate way to do this is to use the keyboard keys: First give the focus to the combo box 
by entering successive <TAB> keys, then press the arrow up/down keys to pass through 
the available effects or type the first letter of the effect name. The current effect is the one 
displayed in inverted colors.  
 
Note: An effect itself requires various parameters, such as its speed, direction etc... For a 
full description, see chapter 1.5.8 
 
Frames may also be set to a rectangle as an attribute. 
 

Activating the Frame push button, as does the 
mouse pointer in figure 11, causes the current 
rectangle to be surrounded by a border. This border 
does not alter the image in any way, neither change 
its dimension. It is simply placed over the image 
while sending. Again a border (or frame) has some 
default parameters (dimension and color) that may 
be modified as required (see chapter 1.5.9). 

 
When working with a superimposed window, the WCB displays the drawing pin 

pushbutton  as seen on figure 12. 
 

Pushing this button, which is default, as the mouse 
pointer does on figure 12. This implies that, the 
superimposed window is said to be stuck to the 
window below it. A stuck image undergoes the same 
effects as the window it is stuck to. This means that 
applying a scroll to a window containing a 
superimposed window, causes this one to scroll as 
well. 

Fig. 10 

 
Fig. 11 

 
Fig. 12 
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When the push button is up, it causes the superimposed window to "free itself" from the 
window below it. The superimposed window remains on the board even if the window 
below it has its contents updated. 
 
Note: to activate or disable those attributes with keyboard keys, proceed as follows: 
 

1. Move the focus inside the WCB to the required button. (when a button has got 
the focus, a dashed rectangle appears on it.)  

2. Press the Spacebar to activate/deactivate the attribute. 

1.5.8 Available Effects 
This section gives a short explanation of the effects and how they influence on an image's 
appearance. 
 
STATIC  This effect transmits the image to the board all at once, so that 

every bulb is switched on at the same time. 
 

DIAPHRAGM This effect transmits the image to the board so that the bulbs are 
switched on from the middle of the image to the edges (open 
mode) or vice versa (close mode). 
 

NEWSCAST This effect is used to transmit horizontally an image that may be 
larger than the RF. Any image may be transmitted with that 
effect, but most often text files (with the .GTX extension) are sent 
so that one single line of text information moves horizontally on 
the board. 
 

SCROLL 
  

This effect sends an image so that it appears at one edge of the 
board and scrolls to the other, whereby the new image pushes 
the old one out.  
 

IN-OUT 
  

This effect scrolls the new image over the old one witch wipes 
away. 
 

GLITTER 
  

This effect provides supplementary, random, continuously 
changing, illumine Ted pixels. 
 

BIJOU  This effect provides a moving border of bubbles around the 
image, with operator selectable bubble size. 
 

DRAUGHT 
  

The existing image is overwritten by the following image in a 
draught board (checker board) effect, moving diagonally across 
the display. 
 

SLIDE   This effect sends an image so that it appears at one edge of the 
board and moves to the other. Thereby the new image covers the 
old one, from one side to the other. 
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BLINK 
  

This effect blinks on and off the requested image on the board. 
The duration is variable and may be given as a parameter. Note 
that in any case, the image blinks at least once. 
 

CURTAIN 
  

This effect sends an image so that it wipes away the existing one 
from one side to the other. Contrary to the slide or the scroll, this 
effect does not cause the new image to move on the board, it 
simply makes the new image appear as a curtain does in a 
cinema. 
 

VENETIAN 
  

This effect divides the current image into equal stripes which will 
be filled simultaneously, line by line, until the whole of the new 
image covers the old one. 
The size of the stripe is defined by the dimension parameter. The 
operator can also choose the speed and the direction. 
 

SALT&PEPPER
  

This effect replaces the old image with the new one in a random 
replacement of pixels, with operator selectable speed. 
 

TELETYPE 
  

This effect simulates a teletype writing, overwriting the old image 
with the new one by means of rectangles covering the surface left 
to right. The speed and the size of the rectangle are operator 
selectable. 
 

FLOAT 
  

This effect is similar to the Newscast, but it may be applied only 
in one direction, from bottom to top. It transmits vertically an 
image that may be larger than the RF. This is useful when 
displaying text like speeches for instance. 
 

ANIMATION  This is a special effect used with files produced by animation 
editors (i.e. Animation Shop program from JASC®, Photo-Paint 
from Corel®, etc…). 
Sending animated GIF, AVI or MPEG files with the animation 
effect causes the animation to be played. Sending ordinary image 
files with this effect causes them to be sent with the static effect. 
 

NONE   This effect is used to remove an image in a rectangle on the 
board. Sending any image with this effect causes the rectangle to 
restore the image beneath it, if any. If there is none, it clears its 
surface. 
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1.5.9 The Frame and Effect Parameters Editor 

Frames and effects are both attributes that may vary depending upon the rectangle they 
are applied to. For instance in certain cases Scroll should occur quickly while in others, 
when displaying some kind of text, it should not. Furthermore an image might sometimes 
be sent with a wider border and sometimes with a narrower border, depending upon how it 
should be emphasized. 
 
The Frame Parameters Editor and the Effect Parameters Editor are tools that allow users 
to set these parameters as required. They both operate in a similar way. 
 
Changing a parameter for an attribute may occur at two different levels: you may change 
the parameters by Default or specifically for a rectangle. Let's have a look at both 
methods. 
 
To set the default parameters for Effects, (in this case: Scroll), proceed as follows: 
 
• Select Effects from the Defaults pull-down menu. This causes a second menu to be 

displayed. 
• Select Scroll from the list of available effects. At this moment, a dialog box like the one 

on figure 13, is activated. 
 
As you can see on figure 13, each 
parameter appears in a group box. 
Pressing the <TAB> key sets the 
focus to the first element of the next 
group box (the Command 
pushbuttons are treated as a group). 
To move the focus inside a group 
box, use the arrow up/down keys. 
 
In this example, following 
parameters may be set for the Scroll 
effect: 
 
The speed parameter determines 
how fast the effect has to go 
through. Click the scrollbar arrows or 
track the slider to increase or 
decrease the speed value. You can 
also directly change the speed value 
inside the entryfield. You may 
choose any value from 1, which is 
the slowest, up to 9, which is the fastest. 

 
Fig. 13 
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The direction parameter indicates the direction of the effect. For example a scroll left, 
which is the pushbutton with the arrow pointing to the left, indicates that the scrolled image 
starts on the right side of the rectangle and finishes on the left side of it. Click on the 
required pushbutton to set the direction parameter or change the direction along the 
pushbuttons with the arrow keys.  
 
The circular parameter indicates whether the effect is to be restarted when arriving at the 
end or not. Unlike a non-circular effect which is executed only once, a circular effect is 
limited in time. Click on "Yes" to set the circular parameter or set the focus on this 
pushbutton and press left/right keys to select Yes or No. 
 
The duration parameter specifies how long a circular effect has to apply to a rectangle. 
Click on the scrollbar arrows or drag the slider to increase or decrease the values. You can 
also directly change them inside the "minutes and seconds" entry fields. You may choose 
any duration from 0 to 59 minutes and 59 seconds, which is the highest. Off course, 
setting a value to this parameter only makes sense if the "circular" parameter is set on ( = 
"Yes"). 
 
The dimension, for the scroll, slide, diaphragm and curtain effects, specifies that the new 
image is separated by a strip from the old one. The dimension number specifies the width 
(in pixels) of this strip. A width of 0 causes no strip to appear while scrolling. 
For the draught board effect the dimension specifies a factor for the size the square, and 
for the bijou border effect the dimension specifies the size of the bubble. 
Click on the arrows to increase or decrease the dimension value or edit the number in the 
entryfield. 
 
The color parameter specifies the color of the strip defined above (Dimension) for the 
scroll, slide, diaphragm and curtain effects. In this case defining a color only makes sense 
if the band dimension is greater than zero. For the bijou border effect, the color parameter 
specifies the color of the bubble.  
Click left mouse button inside the required color box to set the color, or select the required 
color by entering successive arrow up/down keys. 
 
Press <OK> when you are done. This causes the default parameters to be set for the 
scroll effect. This means that each time you apply a scroll to a rectangle, these parameters 
will be set to the scroll. See later in this chapter, how to proceed to overrule this default for 
a scroll of a specific rectangle.  
 
<Cancel> aborts the operation and closes the parameters editor.  
 
Repeat the operations above for all available effects to set their parameters to the required 
default values. Note that the amount of parameters to set depends upon the effect: Thus a 
scroll requires more parameters than a blink, etc...  
 
To set the default parameters for Frames, activate the Frame Parameters Editor as 
follows: 
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Select Frame from the Defaults pull-down menu. This causes the Frame Parameters 
Editor dialog box to be activated on your screen, as displayed on figure 14. 
 
Use this editor similarly to the Effect Parameters 
Editor to set the Band Dimension and Band 
Color parameters. 
 
Press <OK> when you are done. This causes 
the default parameters to be set for frames. It 
means that each time you set a frame to a 
rectangle, it will display as defined in these 
parameters. Again, it is possible to overrule 
them for a frame of a specific rectangle (see 
later in this chapter). 
 
<Cancel> aborts the operation and closes the 
parameters editor. 
 
Once you have customized both the default effects and default frame parameters as most 
often used, there might be situations in which you want to set a thicker frame for one 
particular rectangle or have its effect executed faster than the default would do it. You will 
then need to modify the attributes parameters for that particular rectangle. 
 
Let's take an example of how to modify the speed of a blink effect for a particular 
rectangle: 
 

1. Select an RF that fits the image. 
2. Get the required image into the rectangle. 
3. Select BLINK from the Effect Combo Box in the WCB. 

4. Click the properties button  which is located at right of the Combo Box 
entryfield (or set the focus to the Combo Box by entering successive <TAB> 
keys and enter <CTRL>+E). This causes the Effect Parameters Editor to open 
for that particular rectangle. The initial values are the default ones. 

5. Set the blink parameters as required. 
6. Leave the editor by pressing <OK>. This sets the new values for the blink of this 

current rectangle without changing the default blink values. 
 
Similarly, to set a different frame for one particular image, proceed as described before, 

but click the properties button  which is located close to the frame button (or enter 
<CTRL>+E when the frame button has the focus) to activate the Frame Parameter Editor 
for that precise image. Again, updating these frame parameters does not alter the default 
values for frames.  

  
Fig. 14 
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Fig. 15 

 
Fig. 17 

1.5.10 32K image color mode (only available for OVG installation) 
 

Due to the incapability of the OVG to display image in 

true colors with effect, the 32K colors button  lets the 
user to specify that the image contained in the rectangle 
is an image in true colors (Figure 15). By clicking this 
button, it will not be possible to display an image with an 
effect. 

 

1.5.11 Creating transparency effect 
 
This feature is normally used for a color matrix board. 
To create a transparent effect, for example to display a text in front of an image, a special 
Reference Format has to be created, with a superimposed window. In figure 16, a 
superimposed window has been placed on the top of a full window (using the WFED 
program). It has exactly the same size. If the new FREF has been created and saved with 
WFED program without quitting the Display director program, in menu Ref Formats the 
Refresh command will reload all the Reference Formats. 
 

 
Fig. 16 (WFED program) 

 
 
In Display director program, when the transparence reference 
format has been opened (in this case, its name is TRANSP), 
using the Window Hierarchy dialog (Figure 17), the user can 
set the background image for window 1 by selecting the back 
ground image as defined in chapter 1.5.4.  
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Fig. 18 

 
Then by selecting the window 2 (the one which is 
superimposed) in red in Window Hierarchy dialog 
(Figure 17), the user can select another image or a 
text file to put in front of the background image. In 
figure 19, the results image (Results 800m.grx) as 
been selected to be in front of the 
GradientBlue.bmp image. Finally to validate the transparence, the Transparency button 

 has to be pressed (Figure 18). 
Note that the Preview window does not show the transparency, it is only shown in View 
Online window.  
It is recommended to use the stretch option for the background image.  
It is also possible to set an animated image as background, in this case it is necessary to 
set the effect to ANIMATED in effect field for the background window (in this case:  
window 1). 
 

 
Fig. 19 

 

1.6 Format Commands 
A format is a group of one or more rectangles that contain images. Effects and Frames 
may be assigned to these rectangles. A format is given a name and may be stored on your 
disk for later use. Formats are useful to store images that are often sent to the board with 
the same effects and frame attributes. 



           Galactica - Display Director 
 
 

 
3311.540.02 Version 1.7 Page 17 

1.6.1 Using Formats 

Select New from the Formats pull-down menu (figure 20) to start a new format. This 
causes the Preview window and the WCB to be cleared. The current file name in the 
window title bar is replaced with "Untitled". 
 
To build a format, select the required RF (or build a new one 
with the WFED and issue a "Refresh" command) and get the 
required images into the rectangles as described in chapter 
1.5.4. Then set the required attributes to the rectangles. 
Once this is done, you may save your work on disk. Select 
Save As... (or press <CTRL>+A) from the Formats pull-down 
menu). This causes the Save Function dialog to open. This 
dialog works just like the one described in chapter (under 
"Save As...). "Open..." (or <CTRL>+O) activates the open 
dialog box to prompt you for a format file name. 
 

You can also use buttons  ,  and  to do New function, to Open a Format and to 
Save current Format. Those buttons are available in standard toolbar. 
 
Note that the file to open must be a Format, otherwise a warning message like the one on 
will display. Formats do not require a particular file name or file extension, but it is 
recommended to use always the same extension for all formats (ex: .FMT), so that they 
are recognizable when listing a directory or scanning for files. 
 
Furthermore, it is recommended to save your formats in the same directory or in 
subdirectories of that directory (Generally \FMT\ and its sub-folders). Again, this is not an 
obligation, but it may avoid confusion when managing a great number of image files and 
formats. 
 
To this purpose, the system holds a Default Path in which formats can be saved in. This 
path may be modified as required. Select Paths from the Defaults pull-down menu. This 
causes a dialog box named "Default Directories" to open. Update the Format entryfield 
and press <OK>. This sets your default format path and makes the system open directly in 
this path when a format is requested.  
 
Save from the Formats pull-down menu (or <CTRL>+S) saves the current format under 
the existing name. As a matter of fact, it saves the current state of the WCB and Preview 
window. Note that if you work with an "Untitled" format, "Save" prompts you for a file name 
just as "Save as..." would do. 
Transmit (or <CTRL>+T) directly transmits a format's contents to the board without 
opening it into the Preview. This is useful when you do not want to interrupt your current 
work within the WCB while sending a format to the matrix board. Issuing this command 
activates the same dialog box as when an "Open" command is issued. But in this case, 
pressing the “Open” button causes the selected format to be transmitted to the board and 
the dialog to be removed. 

 
Fig. 20 
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1.6.2 Leaving the Display Director 

Exit (or <Alt + F4>) quits the Display Director program. This command is similar to the 
"Close" command from the system menu. To quit the DD properly, proceed as follows: 
 
1. Save your work (sequences, formats), if you need to. 
 
2. If the remote display controller is connected, disconnect it by issuing a Connect 

command from the Options pull-down menu (the View Online window closes). 
 
3. Leave the Display Director by issuing a "Close" command or an "Exit" Command in 

menu Formats. 

1.7  The Recorder 
The Recorder is a tool that allows users to store successive DD commands into a 
sequence. Thus, a Sequence is a file that may be given a name and stored on your disk. 
The Recorder can load a sequence file and play it as required. Playing a sequence means 
that all the commands included in the sequence file are executed. On the board and in the 
View window, it has the same effect as if you were issuing all these commands separately. 
 
The Recorder is useful when you have several images that are sent always in the same 
manner. You can save much time by assembling them into a sequence. 

1.7.1 Managing Sequences 
 
To manage the Recorder, there are two methods. The 
standard method is to enter menu bar commands from the 
Recorder pull-down menu (figure 21). An alternate way is to 
open the Remote Control Window. Select "Remote Control" 
from the Recorder pull-down menu. This causes the 
command to be checked and the Remote Control Window 
to open (Figure 22). 
 
This window shows graphically the development of the 
sequence. You may have this window active at any time: 
whether recording or playing a sequence, or when working 
with the WCB. 
 
 

 
As shown on figure 22, a counter 
appears in the window. This number 
indicates the progress of the sequence. 
When starting a new sequence or 
invoking the remote window for the first time, this number is always equal to 0. Then there 
are four pushbuttons (play, stop, pause/still, rec) to enter commands. Finally at the right 
side is a static text that indicates the current state of the recorder. At start the state is 
"Stopped".  

 
Fig. 21 

 
Fig. 22 
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To remove the Remote Control Window from the screen, issue "Remote Control" again. 
This hides the window and unchecks the command. 
 
To create, play and save a sequence proceed as follows: 
 
1. Select Recording from the pull-down menu or press the "rec" pushbutton in the 

remote window. This causes the text "Recording" to appear at the bottom of the 
remote window and sets the counter to 1. 

 
2. From now on, all commands marked with a "(R)" are recorded in the sequence. Get 

your images and apply the required attributes, as you would normally do, and send 
them to the board. 

 
3. If you need to interrupt recording the sequence for a while, press the pause 

pushbutton or enter the "Pause" command. The pause button displays still as long 
as the recording is paused (meanwhile the pause command in the pull-down menu 
is checked). 

 
 Press the still button or the checked pause command to resume recording. 
 Note that the still command causes the preview to be cleared. 
  
4. When you are done, press the stop button or enter the "Stop" command. This ends 

the sequence and displays "Stopped" as status text in the remote window. 
 
5. You can now save the sequence if you need to: enter the Save As command from 

the Recorder pull-down menu. This causes the Save Sequence dialog to open. 
 
6. To play the sequence, press the play pushbutton or issue the "Play" command. This 

re-executes the whole sequence (assuming, all files still exist). As status text, 
"Playing" is displayed. While playing, it is, of course, possible to interrupt the 
sequence temporarily ( = Pause) or definitively ( = Stop). 

 
Note that the system keeps the created sequence in memory until another one is loaded, 
so you are able to re-play it as often as required. 

1.7.2 The Sequence Loader 
 
To load a new sequence, select Load from the Recorder 

pull-down or press  in standard toolbar. This causes 
the Sequence Loader window, displayed on figure 23, to 
be activated. If at the time you load a new sequence 
another one is still in memory, you may append the new 
one by checking the checkbox "Append to existing 
sequence". Note that the default state of this checkbox 
is always unchecked, so that the new sequence 
overwrites the old one in memory. If there is no 
sequence in memory at the time you load a new one, (as it may be when you load a 
sequence at start), this checkbox does not appear in the Sequence Loader window. 

 
Fig. 23 



 
 

 
Page 20 Version 1.7 3311.540.02 

Check the "Use default parameters" checkbox to have the current default parameters 
overrule the parameters used at the time the sequence was created. For example, if a 
sequence with some scrolls was created with a default scroll speed of 5, and meanwhile 
this default has been changed to 3, checking this checkbox causes the sequence to 
execute all default scrolls with a speed of 3. The default state of this checkbox is 
unchecked, so that all default parameters used at creation of any sequence are 
maintained. 
 
Select <OK> to validate the selections made in the Sequence Loader or <Cancel> to abort 
the load operation. 
 
When the options have been validated with <OK>, the Sequence Loader window is 
removed and replaced with a usual Open Dialog. Select any sequence file and press the 
"Open" button. If a sequence has been successfully loaded into memory, the status text in 
the remote window changes into "Loaded", otherwise an error message is displayed. 

1.7.3 Editing Existing Sequences 
 
Existing sequences may be modified by the 
Sequence Editor. To edit a sequence, load it 
in memory and issue Edit from the Recorder 
pull-down menu. This causes a dialog box to 
open and display details on the loaded 
sequence, as shown on figure 24. 
 
The list box displays all the commands 
included in the sequence. Use the vertical 
scrollbar to pass along the successive 
commands. Clicking on a command causes it 
to become selected and the detailed 
parameters of the command are displayed in 
the text window below the list box. 
 
Example in figure 24: The command is Select Effect Salt&Pepper and apply it to the first 
rectangle of the selected Reference Format. 
 
To remove a command in a sequence, click on that command (so that it becomes 
selected) and issue Remove Command from the Actions pull-down menu (or use the 
<Delete> key). 
 
Delay and Pause 
 
When creating sequences, there might be situations 
when you want to delay the processing of the 
sequence. To this purpose, the Sequence Editor allows 
you to insert either a fixed time delay or a stop point 
where the sequence must pause till the user of the 
sequence explicitly enters a command to carry on. 

 
Fig. 24 

 
Fig. 25 
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Use Delay from the Commands pull-down menu to insert a delay next to the currently 
selected command. This causes a dialog box like the one on figure 25 to open. Here you 
may enter the duration of your delay. The default value is 1 second, but you may specify 
any values up to 600 seconds (=10 minutes). <OK> sets the delay into the sequence and 
removes the dialog, <Cancel> aborts the operation and returns to the sequence editor. 
 
Use Pause from the Commands submenu in the Recorder pull-down menu to insert a 
break next to the currently selected command. When a sequence is being played, a pause 
causes it to interrupt the processing and wait for a still command to be entered by the user. 
Note that this command increments the Recorder counter as any other command does. 
 
Labels & Goto 
 
Labels and Goto are used to repeat part of or all the sequence. A Label is a fixed point in a 
sequence that you can reach from anywhere with a Goto command. 
 
Example: 
 
 New 
 LABEL START [Endless] 
 GET IMAGE [1] Name 
 GET IMAGE [2] Firstname 
 TRANSMIT 
 GOTO START 
 
This short sequence uses a label named START to transmit endlessly two rectangles of an 
RF until the user issues a stop command. Select the command where you want to insert a 
label and issue Label from the Commands pull-down menu. This causes a dialog like the 
one on figure 26 to be activated. 

 
Enter the Label name in the entryfield Label identifier. If 
the Endless radio button is activated the commands next 
to the label are always executed. On the other hand, if 
the Counter radio button is activated (with a number of 
loops going from 1 up to 99), it causes the commands 
coming next to the label to be executed the number of 
times required. 
 
 
 

 
To insert a goto command, issue Goto from the Commands pull-
down menu. This causes a dialog like the one on figure 27 to be 
activated. All created labels are displayed in the list box. Select the 
required one and press <OK>. 
 
 
 

 
Fig. 26 

 
Fig. 27 
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Fig. 28 

Online Images 
 
The Online Images feature of the Sequence Editor allows users to decide which images to 
insert in the sequence at the time the sequence is being played. This avoids creating 2 
different sequences for a lineup presentation of 2 teams, for instance. 
 

Online Images are defined as follows: In the Sequence 
Editor, mark as selected the Get Image where you want 
to insert an online image. This causes the Online Images 
command from the Commands pull-down menu to be 
activated. Issue this command and a dialog like the one 
on figure 28 will display. 
 
In this dialog, users may specify the image number in the 
Image # entryfield. There are 10 available online 
selections that can be made at load time (# from 0 up to 
9). The image may come either From Disk or From a 
Maker. Check the requested radio button in the Source 
group box. 

 
When the At Load Time radio button is checked, the system prompts users for the image 
name at the time the sequence is loaded, i.e. when the Load command is issued (see later 
in this chapter). On the other hand, when the At Run Time radio button is checked, the 
system always prompts users for the image name at the time the sequence is being 
played. There can be as many images as wanted set online at run time. Note that querying 
an image name at run time causes the sequence to pause and to display the dialog to 
query for a filename or maker image. 
In the figure 28, the message “already used” on the top right of the dialog specifies that 
this online image (in this case # 0, defined at load time) is already used at least in another 
command of the sequence, in this case command number 3. 
 
<Cancel> aborts the Online Image Selection without saving any changes, while <OK> 
saves the Online Image at the current position in the sequence, closes the dialog and 
displays the new detailed parameters of the command in the Sequence Editor text window. 
 
While editing a sequence, it is also possible to start recording from the current position 
inside the sequence. Press the <Record> pushbutton (its text appears in red) to start 
recording. This causes the Sequence Editor window to be removed from the screen and 
the Preview window to display the current state of the sequence, i.e. all commands 
recorded previously are executed up to the current command. 
 
To end a sequence edition, press <OK> to validate the changes made or <Cancel> to 
abort the edition without saving any changes. Play the sequence to test it and then save it! 



           Galactica - Display Director 
 
 

 
3311.540.02 Version 1.7 Page 23 

When playing a sequence that contains 
online images that must be initialized at 
load time, a dialog like the one on figure 
29 is displayed at start. 
 
This dialog allows users to enter the 
image file names when a sequence that 
requires online images is being loaded. 
The system detects which image 
numbers require a name for the current 
sequence and displays an entryfield on 
this line, as it does for image number 0 
and 4 in the figure. The source of an 
image may be the Disk or a Maker as it 
is displayed in the dialog. Type the 
required image name in the entryfield or 
select it by pressing the browse button, 
which opens the dialog to select an 
image according to its source (Disk or 
Maker).  
 
Press <OK> to validate your selection. This causes the dialog to be removed and the 
system holds now the image names given as online parameters. If an image name is 
unknown or invalid, another one will be prompted at run time. To modify the image names 
initialization, for example when you want to play the same sequence with other images, 
select Online Image Initialization from the Recorder pull-down menu. This causes the 
dialog to be displayed again. Note that this command is only active when there is an online 
image defined for this sequence. 

1.7.4 Naming and Storing Sequences 
 
Like formats, sequences do not require a particular file name or file extension to be stored 
with. It is nevertheless recommended to use always the same extension for all sequences 
(ex: .SEQ), so that they are recognizable when listing a directory or scanning for files. 
 
Furthermore, it is recommended to save your sequences in the same directory or in 
subdirectories of that directory. Again, this is not an obligation, but it may avoid confusion 
when managing a great number of image files, formats and sequences. 
 
To this purpose, the system holds a Default Path in which sequences can be saved. This 
path may be modified as required. Select Paths from the Defaults pull-down menu. This 
causes a dialog box named "Default Directories" to open. Update the Sequences entryfield 
and press <OK>. This sets your default sequence path and makes the system open 
directly in this path when a sequence is requested.  

 
Fig. 29 
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1.8 The Quick Launch window 

1.8.1 Introduction 
To display the Quick Launch window (Fig. 30), use the 
command View / Quick Launch or press  in the 
standard toolbar. This command is used when the 
operator needs to access quickly formats, sequences or 
images which are saved on the hard disk.  

1.8.2 How to add shortcuts 
When you have prepared a Format, a Sequence, a 
Connection with Maker, or just an image, you can create 
a shortcut to it in Quick Launch window. This way you 
can have access really quickly to all your favorite board 
images especially those which are the most common 
used.  
  
First of all create folders by clicking with the right button 
in Quick Launch window and selecting New  Folder… .  
We strongly recommend you to sort out all your 
shortcuts in several folders. This will help you find again 
all the images according to a theme or a sport.  
 
When the Format, the Sequence, the image or the text 
file are saved on the hard disk, just right click on the Quick Launch window, select New  
Shortcut…, and browse the hard disk to find the file you want to shortcut. To create a 
shortcut to a Maker connection, select New  Maker Shortcut…,then the list of running 
maker will appear and you just have to select one. Note that this kind of shortcut does the 
following thing: in background the DD opens the FULL reference format and inserts the 
maker image on it. By default, the Galactica will attribute the name of the file to the 
shortcut or in case of maker shortcut the name will be “Connection to MAKER1”. You can 
easily change this name by selecting Rename in the contextual menu or by left clicking on 
the shortcut for a few seconds. Galactica also attributes an icon to each shortcut according 
to the file type. This feature helps you know quickly if it’s a Format, a Sequence, a 
Connection with Maker, a Text file or an image. The following array shows the meaning of 
each icon: 
 

Shortcut to: 

Format Sequence Maker Image Text file 

     
 

                                            
1 Maker name 

Fig. 30 
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1.8.3 How to use shortcuts 

 
Single click with matching action:  

 
 

Shortcut Action 

 Format 

 Maker connection 

 Image 

 Text 

Shows the format, maker 
image, image or text file in 
Preview window. But it 
does not send it to the 
board.  
To send it, you can use 
<+> key on numeric 
keypad. 

 Sequence Loads the sequence, but 
does not play it. 

 
 

Double click with matching action: 
 
 

Shortcut Action 

 Format 

 Maker connection 

 Image 

 Text 

Sends the format, maker 
image, image or text file to 
the board (View Online 
window), without changing 
the Preview window. 

 Sequence Loads and plays the 
sequence. 
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1.9 Other DD Features 
Following commands are also available in the Options menu. 

1.9.1 Connect or disconnect the link with the display controller (DPCT program) 
Connect check menu allows you to be connected or disconnected with the board. (In 
reality it is the connection with the DPCT program which is in charge to create the final 
image) 

1.9.2 Scoreboard settings... 
The scoreboard settings open a specific dialog for each sort board. Generally this dialog 
lets the user set parameters of the scoreboard like luminosity, contrast, .... This dialog 
could be completely different between two different boards. One common command is the 
Freeze button which allows user to freeze an image on the board and test locally a 
sequence for example without displaying it on the board. 

1.9.3 View Window Numbers 
The View Window Numbers command toggle allows the operator to hide, or alternatively 
to show the window identifier in the Preview window. This command can be used if we are 
working with some very small windows or to view some particulars of the preview image 
hidden by the identifier. 

1.9.4 Startup Options 
The Display Director may be started 
automatically at the startup of the 
system. This function can be activated 
in the following way: 
 
- Copy the shortcut Display director in 
Startup menu. 
 
The Display Director Startup Options, 
in the Defaults menu of the Display 
Director are be implemented to start 
the program without any operator 
manipulation. 
 
To configure "how to start", select the Startup Options entry in the Defaults pull-down 
menu; the dialog Startup Option will be activated. 
 
In this dialog, you can check the entry Connect Display Controller to directly connect the 
board. 
To select a default Format and Sequence, choose it using the corresponding open button 

 . 

 
Fig. 31 
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Check the Open Format checkbox if you want to load the corresponding format and check 
the Load Sequence if you want to load the corresponding sequence. 
 
In the command group, select the radio button corresponding to the command you want to 
execute at startup. 

1.9.5 Image options 
 
The default settings regarding image transmission 
can be set by using the menu Default / Image 
Options. The dialog shown in figure 32 appears. It is 
possible to set that all gif images have to be 
considered as an Animated GIF.  
 
The second setting let the user to disable Warning 
message when an effect is in progress on the board. 
 
 
 
 
 

1.9.6 View Tree 
In View menu, the View Tree command toggle controls whether, or not, the hierarchy tree 
of windows contained in the Reference Format, is displayed in the DD Working Space. 
This command is used when the operator need more space on the screen in order to open 
some other programs. 

1.9.7 View Quick Launch 
In View menu, the View Quick Launch command toggle controls whether, or not, the Quick 
Launch is displayed on screen; you can also use the button  in toolbar.  
 
 

 
Fig. 32 
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1 INTRODUCTION – THE IMAGE EDITOR (IMED) 

1.1 Image editing 

The image generator utility defines the content and appearance of the images created by 
the MAKERS programs. 
  
Each image is completely definable by the operator, who selects the content and style of 
the information; these images are then updated by the MAKER program, which takes the 
changes to the database into account. 
 
To prepare an image, choose the Images menu in the menu bar, then the name of the 
image you want to edit. The Field Parameters editor (Fig. 1) and the Preview Window (Fig. 
2) are displayed. 

 

 

 
                         

 
 

Fig. 1 Field Parameters Editor 

Fig. 2 Field Preview Window 
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1.2 The image editing screen (Field Parameters) 

An image is defined as a series of fields. 
 
Each field is defined by a series of parameters, such as size and position. 
 
When the image editor is open, the program defaults to the first field and displays the 
values and information defining it. 
 
There are three ways to move from one field to another. The first one is to select field 
using the mouse in the Preview Window. The second one is to select the field in the field 
list, and the last one is to use the [>>+] and [-<<] buttons. Insert creates a new field, 
Remove deletes an existing field, Move Up and Move Down button change the field order. 
 
A new field is inserted after the field currently highlighted. The field order is important only 
if one field partially obscures another; in this case, the new field will cover the previous 
one, which will be only partly visible. 
 
When a new field is inserted, it is automatically called "Untitled" 
in the field list.  
It is possible to change this field name by double clicking on it, 
this will open a dialog (Fig. 3) which lets the user to rename the 
field. If a field has to be duplicated, the program will 
automatically add index like (0), (1), (2), etc... 
 
 
When a field is deleted by using the Remove button, it is deleted from the list of fields 
comprising the image. 
  
A Preview Window (Fig. 2) displays the image on line. This 
window can be moved around freely and can be zoomed if 
required.  It is constantly updated with the fields that make up 
the image to display the editing results directly. A popup menu 
can be used in this window (Fig. 4), it allows the user to add or 
remove a field and set the zoom factor. To get this popup menu, 
the user has just to right click in this window. 
The easiest way to change the zoom factor of the Preview Window is to use the mouse 
wheel when the Preview Window owns the focus (= is active). 
 
Clicking on the OK button closes the window and saves all the changes made to the 
image. Clicking on Cancel closes the window without saving the changes. 
 

Fig. 3 

Fig. 4 
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1.3 Parameters 

1.3.1 Information 

Specifies the information to be displayed in the field, it could be: 
 
- A free text: To insert information directly, position the cursor in the field and 

enter the information from the keyboard.  The information 
appears in the field if it is of the text type 

 
- An Image: To insert an image, select one on the hard disk using menu 

Actions/Get Image from disk or using the  button. 
 
- A database information:  To match the field with a database information, select the 

database entry on the database list using menu Actions/Get 
database table or using the  button. The type is positioned 
automatically when the file is compared with the database, and 
takes precedence over manual type selection; thus for example 
if a field has been compared with a database entry of the bitmap 
type, it does no good to reposition the type because it 
automatically defaults to bitmap. The description of the various 
database fields is described in detail in the MAKERS program 
manuals. 

1.3.2 Display mode 

Normal field is generally and by default set as Visible.  
 
Hidden option allows a field to be hidden temporarily. Instead of deleting a field that is 
required only temporarily (which would mean losing all the values defining it), it can be 
hidden. A condition for hiding a field could be set ("Swimmer's name(0)" in figure 1, does 
not appear into the image when generated if the STARTLIST_LANE[0]is empty). 
This option allows user to decide if he wants to hide a field when another one is empty. In 
a Diving image, for example, it is necessary to display the total points received for a dive 
on the bottom right part of the board like XXX pts. The XXX part can be the database field 
PRESDIVE_SCORE[0] and pts can be a free text. As long as the XXX value is empty, the 
pts field has to be hidden. It has only to be displayed when the database entry 
PRESDIVE_SCORE[0]has been filled. 

1.3.3 Type 

Field matched with database entry could be: 
 
- Text:  defines a set of alphanumeric characters. 
 
- Image: defines an image created by the system editors (Pictures, logo, etc...). 
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In example, for the country field, in Text mode, it will display the IOC country code (i.e. 
FRA) otherwise in Image mode the program will search on the hard disk (in the Flags 
folder or Photos folder) the matching file starting by FRA and having extension .bmp. This 
feature is explained in details in chapter 1.4. 

1.3.4 Colors 

Allows definition of field "background" and "foreground" colors. If the field is text 
type, the background color is used to fill in the background of the field and the 
foreground color is used for the text. If the field is the bitmap type, the background 
color fills the part of the field that will not be covered by the selected image. 
 
For RGB board, an additional cell is available to select a custom color. By 
selecting this cell the standard Windows® dialog box to select colors will be 
displayed. 
 
For non-RGB board, clicking in the drop down list shows only the available colors 
(black and white for Monochrome board, and red, orange and green for 3 colors 
board (RG)). 
 
When there is a multi layers image the transparent checkbox is really useful. It 
allows to set the background color as transparent. By this way it is possible to 
have a background image and all the data coming from the database in front. 

1.3.5 Size & Position 

Defines the size and position of the field (values in pixels) (Fig. 6). These fields can be 
edited, but generally are used only for visualization; positioning is easier using the mouse 
(Fig. 7).  

 

     
    

 
When the positioning window is displayed, the field can be dimensioned and positioned 
easily using the mouse. The new values in main window are automatically updated during 
the move. The two buttons  and  allow the user to center the field respectively 
vertically or horizontally on the board. 
In Preview Window, the keyboard arrows can be used to change the position of the field 
and whilst maintaining the Shift key down, its size can be changed pixel per pixel. 

Fig. 5

Fig. 6  
Fig. 7 
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1.3.6 Field effect 

This function defines the effect that will be used to display the field. 
Available effects are: 
 
STATIC   Default effect, it means that no effect is applied on the field, the content of the 

field is displayed all at once. 
BLINK   The content of the field blinks. 
 
NEWSCAST   The content of the field moves horizontally from right to left. 

1.3.7 Justification 

Text fields can be justified horizontally and vertically so that when the information changes, 
the field will be attractively displayed.  
Horizontally, the operator has a choice between flush left, flush right, and centered text. 
Vertically, the text can be positioned at the top or bottom of the field or centered. 
All database fields have a defined size. Every program which write data in those fields fill 
them with spaces and then write data. Those spaces can be removed by using the Trim 
option. 
It is also possible to change the position off first displayed character by using Offset. Offset 
can be lower than 0 for offsetting from the end.  
Note that vertical positioning is done relative to the character as defined by its total matrix, 
so that characters that descend below the baseline or go up to the last pixel of the matrix 
(accented characters, for example) will be displayed correctly.  
Note also that if the selected font is larger than the field or if the text is larger than this 
same field, the text will be only partially displayed. But there is a possibility to insure that 
all the characters are displayed in the field, by checking the checkbox Fit to field. By this 
way, the software will automatically stretch or reduce the font size without taking into 
consideration the one selected by the user. This feature is really useful to display a score. 
For example, as the score generally is less than 10 to 10, the user wants to be sure that 
when it is higher, all the numbers are displayed. 

1.3.8 Attributes 

Bitmap fields can either be Stretched or Centered. 
 
Stretched means that the bitmap must fill the field completely. If the dimensions of the 
bitmap do not match the dimensions of the field, the bitmap is redrawn to fill the entire 
field. If larger, it is reduced by deleting lines and columns of points; if smaller, it is 
expanded by adding adjacent lines and columns of points.  
 
Centered positions an image starting at its center. 
 
The Stretched mode takes precedence over the Centered mode. The two are incompatible 
simultaneously. 
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Fig. 8

1.3.9 Frame 

Draws a frame around the field. The numerical value specifies the size of the frame (0 
means no frame, 9 is the largest). The drop down list is used to select the color of the 
frame. 

1.3.10 Shadow 

Text fields can be displayed with a shadow. This is especially useful when generating 
colored images. The numerical value specifies the displacement of the shadow relative to 
the text (negative values are allowed). 0 indicates that no shadow is desired. The drop 
down list is used to select the color of the shadow.  

1.3.11 Font 

For text fields, the font used to display the text can be selected. All system fonts are 
available.  
The font selection screen can be called up directly using the menu Actions/Select Font or 
using the  button. Note that if Fit to field option is checked, the data in field will be written 
without taking into consideration the font size selected. 

1.3.12 Duplicate Fields 

 The 'Duplicate Field' screen is used to generate vertical or horizontal 
fields with the characteristics of the current field. 
Number of fields specifies the number of fields to create, Vertical 
offset specifies the number of vertical pixels from one field to 
another. The default value is the size of the field, or the last offset 
used. 
Horizontal offset specifies the number of horizontal pixels from one 
field to another. Shortcut for this function is Ctrl + U. 
 
We strongly recommend to use this function for generating images like startlist or ranklist. 
First of all, place and set all the parameters for the first competitor, test it, and finally use 
the Duplicate function to copy the selected field parameters.  
If the field is a database field (like PLAYER_NAME[0]), the data referred by it will be 
automatically increased for the duplicated one (like PLAYER_NAME[1], 
PLAYER_NAME[2], PLAYER_NAME[3], etc… ).  
Warning: the program could generate fields outside the image. Be sure that all fields you 
duplicated are inside the image. 
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1.4 Special feature: displaying automatically photo and flag 

Country flag, club logo or photo could be automatically 
displayed according to database information.  
 
In figure 9, there is a field with the athlete’s picture. In fact, this 
is the athlete’s name coming from the database, but instead of 
choosing Text type, Image has to be selected. The same has 
been done for the fields showing the country flag. The variable 
is country flag when Image type is selected. When text type is 
selected, you get the short country code coming from the 
database. 
 
To allow this feature, it is necessary to set where the program 
could find flag images and athlete's pictures. To do that, select General Settings... in 
Options menu. The figure 10 shows the window which will allow user to set the 
pictures/flags paths. Another feature of this window is that it is possible to associate 

special characters like &, , etc… (normally 
characters which cannot be a filename) to a filename. 
In \\SWISS TIMING\GALACTICA\IMG there are 
folders called Flags 150x100 or Flags 40x27. To 
display flags, the program uses the country code 
found in the database entry and checks in the flag 
folder if there is a BMP filename beginning with the 
same letters. In figure 9, database entry contains 
RUS, the program checks for RUS*.BMP, finds 
RUS_Russie.BMP and displays it. 
If the competition is a regional competition, you can 
create your own folder with your own regional flags or 
logos starting with club short name for example, and 
then follow the competitor database with the club 
short name instead of nationality. 

 
 
 
 
 
 
The same system is done for photos, but in this case the program uses concatenation of 
the athlete's name, and adds BMP. In figure 9, the athlete's name is POPOV Alex. The 
program checks in Photos folder if there is a file called POPOVAlex.BMP. 

1.5 Images generated 

The image generator saves and reads the images to and from the disk in the MAKER 
directory: 
\\SWISS TIMING\GALACTICA\PRM, with the extension .IGF 

Fig. 9 Sample: 
Swimming presentation 

The nationality has to be one of the IOC country code (Example: FRA: France; GER: 
Germany; SUI: Switzerland, etc...) to use flags defined in Flags 150x100 or Flags 
40x27 folder. 

Note 

 
Fig. 10  
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1 INTRODUCTION – TEXT EDITOR 

1.1 Description 

This text editor has the same functions as a basic word processor; it allows to edit the *.grx 
and *.gtx files of the Galactica and to open the *.txt files. 
It offers many options for the edition: parameterisation of the fonts, insertion of colours or 
background image, different work surface. 
To start the TextEditor, double-click on the TextEditor icon. 

1.2 Working space of the TextEditor 

 
Fig. 1 

 
  Working surface of the TextEditor (space at your disposal to edit text). 

The size corresponds to the size of the board or to a RF window (Reference 
Format). 

 Indicator of the left margin. 

  Indicator of the right margin. 

  Drop-down list for choosing the font according to the language used. 

 Drop-down list for defining the size of the font used. 

  Font format (Bold, italic, underlined) 

  Text alignment 

  Colour of the font 

  Colour of the font’s background 
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1.3 Edition of a text 

The cursor blinks in the working surface; it is now 
possible to start the introduction of a text using the 
keyboard (Fig. 2). 
The system senses the end of the line during the 
introduction of the text and automatically makes a line 
skip. 
If the text is bigger than the working surface, the scroll 
bar comes on. To move into the text, use the scroll bar or 
the arrows of the keyboard (the arrows of the scroll bar 
allow to move by line). 

1.3.1 The current keys 

 <Backspace> : Erases the character situated on the left of the cursor 
 <Delete> : Erases the character situated on the right of the cursor 
 <Home> : Moves the cursor to the beginning of the line 
 <End> : Moves the cursor to the end of the line 
 <Ctrl><Home> : Moves the cursor to the beginning of the text 
 <Ctrl><End> : Moves the cursor to the end of the text 
 <PageUp> : Moves the scroll bar by page to the top of the page 
 <PageDown> : Moves the scroll bar by page to the bottom of the page 
 <Ctrl> <A> : Selects the whole text 
 <Ctrl> <X> : Cuts the selection and puts it into the clipboard 
 <Ctrl> <C> : Copies the selection and puts it into the clipboard 
 <Ctrl> <V> : Pastes the content of the clipboard to the position of the cursor 
 <Ctrl> <L> : Aligns the text on the left 
 <Ctrl> <E> : Aligns the text in the center 
 <Ctrl> <R> : Aligns the text on the right 
 <Ctrl> <I> : Inserts a space to the position of the cursor 

1.3.2 Shifting with the mouse 

The mouse can be used to move the cursor quickly on a precise point of the working 
surface, at the beginning of a sentence or a word for example. It is not possible to position 
the cursor in a zone where there is no text. With a mouse equipped with a wheel in place 
of a central button, it is possible to move the scroll bar with it. 

 
Fig. 2 
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1.3.3 Selecting a rectangle of a Reference Format 

In order to proportion the working surface, the TextEditor can work with Reference 
Formats created by the WFED (Window Format Editor). When starting the application, the 
working surface, by default, corresponds to the whole surface of the display. To change 
the size of the surface: 
 

1. Select Select a format RF in the Format menu. The available RF will be displayed in 
a list. 

 
2. Choose a RF by double-clicking on its name or by selecting it with the mouse and 

then press OK. The rectangles of the RF will then be displayed in another list. 
 

3. Select the wanted rectangle. 
 
 
If the working surface is not empty, the system will suggest you to save the work in 
process. 

1.3.4 Copying the content of a rectangle of a Reference Format into another 
rectangle Reference Format 

It can be useful to copy the content of a RF when there is a need to transfer the whole 
content of a RF into another RF format. 
 
Here is the procedure:  
 

1. Select Send the current RF in an other RF… in the Format menu. The available RF 
will be displayed in a list. 

 
2. Choose a RF by double-clicking on its name or by selecting it once and validating 

with OK. 
 

3. Select the wanted rectangle. 
 
When going from a big RF to a smaller one, the disposition of the text can be affected 
because of the working surface. 

1.4 Using different fonts 

During the edition of a document, all the Windows fonts that are installed can be used. 
The font is identified by a name and its size. Most of the fonts are proportional, which 
means that the width of a character depends on the character that has been typed. For 
example, the letter ‘M’ will be wider than the letter 'l' for a proportional font. 
 
The system also offers non-proportional fonts, where each letter and number has the 
same width (For example Terminal, OESmall Font,…). This sort of font is really useful to 
align text. 
 
It is possible, at any time, to know which font is being used by consulting the toolbar of the 
text editor or by choosing Select Font in the Edit menu. 
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The font can be changed by opening the pop-up menu 
of the toolbar and by selecting the font (Fig. 3). 
The size of the font can be chosen in the same way, 
using the pop-up menu situated on the right of the 
fonts. Using the buttons  allow to define the 
formatting of the character respectively bold, italic and 
underlined. 
While moving into the edition area, the toolbar shows 
the font that is being used at the position of the cursor, 
as well as its size and style. 
 
If the font is not shown when one is positioned on a character, it means that the font is 
using the multilingual mode. For more info, please refer to chapter “Using the TextEditor in 
multilingual mode". 
 
It is also possible to change the font, the size and style from the dialog box (Fig. 4) Select 
Font in the Edit menu. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
In order to change a number of lines that are already written, you just need to select in 
brightening the wanted line(s). 
Then choose a font as explained at the beginning of this chapter. 
 
Some characters such as grammatical accents might be displayed in a different way 
depending on the chosen font. 
 
Warning ! While selecting in brightening many written lines with different fonts, the name of 
the police does not show in the toolbar. 

 
Fig. 3 

 
Fig. 4 
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1.5 The colours 

1.5.1 Using the colours (black & white display board) 

During the edition of the text, you normally work 
with white characters on a black background. To 
invert these colours, select the colour of the font in 

black in the toolbar . 
To change the ground colour, select Colour of the Background menu and select the 
background colour (Fig. 5). 
 
The brightening function only works on a white background by putting the back of the 
characters in black (Fig. 6). 
 
To achieve the brightening function: 
 
1. Change the colours as explained above. 
 
2. Select the text in brightening. 

3. Select the colour of the font in white . 

4. Select the background of the font in black . 
 

1.5.2 Using the colours (colour display board) 

When using a colour display board, the maximum number of available colours is 16 or less 
according to the type of colour display board used, this being valid for the three following 
entities:  
 
1. The first ground of the character 
2. The background of the character 
3. The background of the window, it is of one colour only (black by default). 
 

To change the colour of the character, go in the pop-up menu of the toolbar  or the 
font dialog box by selecting Select Font of the Edit menu. 
 

To change the colour of the character, use the pop-up menu of the toolbar . 
 
By selecting many characters in brightening, it is possible to modify in one go the colour of 
the fonts and their background. 

 
Fig. 5 

 
Fig. 6 
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For the background of the window, open the Background 
Colour window (Fig. 7) by selecting Colour of the Background 
menu, select a colour using the pop-up menu and then 
confirm with OK. 

1.6 Work on the text 

1.6.1 Using the justifications 

The TextEditor has different modes of justification (Fig. 8). 
 
 
 
 
 
 

 Align left, the mode by default, aligns the text on the left margin. 
 Align center, centers the text so that the distances between the left and right margin 

are equal. 
 Align right, aligns the text on the right margin. 

 
The alignment is applied to the paragraph in progress. To know which alignment has been 
used for a paragraph, you need to be positioned on it with the cursor, and the alignment 
button will activate itself in the toolbar. 
 
An alignment can be applied to a whole block of lines by selecting the lines in brightening 
and by selecting the wanted alignment. 

1.6.2 Using the margins 

The TextEditor permits to position the margins for every paragraph. 
 
To position the margins: 
 
1. Left margin: 
 
When the shape of the mouse’s pointer changes (Fig. 9), go in the bar situated above the 
edition zone, click and keep pressing on the button, then move the margin (Fig. 10). 
 

 
2. Right margin:  
 
Proceed as described above. 

 
Fig. 7 

 
Fig. 8 

 
Fig. 9 

 
Fig. 10 
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1.6.3 Using the cut, copy and paste functions 

The functions are particularly useful for duplicating text on different places of the edition 
zone. 
 
How to displace some text: 
 
4. Select the text to be moved in brightening. 
5. Choose Cut of the Edit menu. 
6. Position the cursor where the text must be inserted in the edition zone. 
7. Choose Paste of the Edit menu. 
 
How to copy some text: 
 
4. Select the text to be copied in brightening. 
5. Choose Copy of the Edit menu. 
6. Position the cursor where the text must be inserted in the edition zone. 
7. Choose Paste of the Edit menu. 
 
The cut, copy and paste functions can also be accessible in the toolbar  or by a 
contextual menu. To make the menu appear, it is necessary to be placed with the mouse 
in the edition zone and to right click with the mouse. Then select the wanted function with 
a left click on the mouse. 

1.7 Using the TextEditor in multilingual mode 

The TextEditor permits to edit texts in several languages that have a different character 
style such as Greek, Arabic, Japanese, etc… 
 
In order to do that, it is necessary to have an operating system such as Windows® 2000 or 
Windows® XP and have installed the different languages codes. 
 
To install the different character codes of the wanted languages, follow this procedure:  
 
Open the configuration panel of Windows. 
Select Keyboard with a double click and the Keyboard Properties window will open. 
Select the Input Locales  tab. 
The language by default of the operating system chosen at the installation is situated in 
the Input Locales window. 
Click on Add and the Add Input Locale window opens itself. 
In Input Locales, select the language that you want to add. 
In Keyboard layout/IME configuration, select the keyboard language that you want to add. 
It is possible that in some cases, the Windows CD is required. 
In the Input Locales window, make sure that the tick Enable indicator on taskbar is 
selected. 
Click on OK and from then on the language indicator , , ,…, is displayed in the task 
bar, regarding the language that you have installed. 



 
 

 
Page 8 Version 1.2 3311.547.02 

Using the TextEditor in multilingual mode:  
 
1. Once the languages codes are installed, open the TextEditor application. 
2. Click in the edition zone in order to define to which application the language must be 

affected. 

3. In the task bar, left click on the , , ,… logo, depending on the language that is 
being used. 

4. A menu opens with the languages that have been installed; select the wanted 
language by clicking on it and the TextEditor automatically applies the selected 
language. 

 
The modification of the language modifies the list of the available fonts in the toolbar. 
When using several languages in a document, it is possible that the name of the font does 
not appear in the toolbar; this is due to the fact that another language for this word or line 
is being used. To make the corresponding font of a word or line appear, select the 
language that has been used again. 
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1 INTRODUCTION – THE WINDOW FORMAT EDITOR (WFED) 

1.1 Description 

Often images which are sent to a matrix board are not full board images but rather images 
that are composed of several other images. To achieve this, the matrix board window has 
to be split up into several rectangles that are to be treated individually as independent 
boards. 
 
The Window Format Editor is the tool to realize this "splitting". It may afterwards be used 
by the Text Editor. This allows it to edit directly in a window defined that way. Likewise, the 
Display Director frequently works with different board windows; it might, for instance, send 
images covering only part of the board or apply effects on some precise images, etc... 
 
Thus, the WFED is often used to prepare window formats, long before the Display Director 
uses them. 

1.2 Definitions 

Here are some definitions used within the description of this program: 
 
A Reference Format (=RF) defines a full board display split up into one or more rectangles 
which are defined by their size and position. A Reference Format is identified by a name 
and is stored on your disk. 
 
Note that an RF only defines sizes and positions of rectangles; it refers in no way to 
images that will later be in these rectangles. 
 
A Superimposed Window is a user-defined rectangle, contained in another rectangle. An 
image may be set to a superimposed window and an effect may be applied. On the screen 
a superimposed window appears in red. A superimposed window cannot contain any other 
window; it is always at the highest level. Superimposed windows are used to put an image 
over another one. Example: a running time over a game score image. 
 
A Window is a user-defined rectangle in which an image may be displayed. An effect also 
may be applied to the image contained in a window. On your screen, windows appear in 
green. They may contain one or more superimposed windows. 
 
An Area is a user-defined rectangle on which an effect may be applied, but no images may 
be sent in them. An area appears in gray and may contain one or more windows and 
superimposed windows. Areas are used to apply an effect to several windows at a time. 
For example, an area may contain two windows, or a window with a superimposed 
window. 
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Note about images and effects: The Display Director decides where an image is to be sent 
and how. But in any case there are some rules to take into consideration when building an 
RF: 
 
1. There can be only three levels of rectangles: areas, windows and superimposed 

windows. 
 
2. Windows cannot overlap. 
 
3. The window width (x size) and position must be modulo 4. Example of valid sizes or 

positions: 144, 40, 60. 
 
4. An RF cannot contain more than 20 rectangles. 

1.3 The WFED Working Space 

On Fig. 1, you can see a WFED working space: Example is the name of the current 
Reference Format, rectangle 1 is an area, rectangle 2 a window and rectangle 3 a 
superimposed window. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The WFED appears as an ordinary window. The menu bar contains four menus: 
Reference Formats, which allows to create, select or modify a reference format, Windows, 
which adds, suppresses or modifies a rectangle of an RF and View which allows to change 
the Zoom factor and enable or disable the toolbar. 

Fig. 1 The WFED Working Space 
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The Tree shows the hierarchical position and definition 
of the rectangles built in the current reference format. 
Each tree element corresponds to one rectangle. It 
contains 4 entry fields displaying the size and positions 
of the rectangle as well as a rectangle identifier, 
located at the left edge of the tree and computed 
internally by the system. The size and position 
numbers of a rectangle may be modified as described 
later in this chapter. On the right edge of a tree 
element is the checkbox to superimpose rectangles. 

1.4 The WFED Commands 

1.4.1 "Reference Formats" commands 

"New":       Opens a new RF. Note that a confirmation will be asked in case the current 
RF has not been saved. 

 
"Open":     Opens an existing RF. This command activates a list box displaying all the 

available RFs. Press <ENTER> to confirm the selection and display the 
selected RF on the screen. A confirmation will be asked in case the old RF 
has not been saved 

 
"Save":      Saves the current RF on your disk. Note that the RFs are saved in a system 

file that cannot be accessed by users. In case no RF is active when this 
command is issued, the system displays a warning message.  

 
"Save As": Saves the current RF under a new name. This command activates an entry 

field to give a new name.  
 
"Remove":  Deletes an existing RF. This command activates a list box to select an RF 

name and suppresses it when the command is validated by <ENTER>. 
<CANCEL> aborts the deletion and returns to the WFED working space. 

 
"Exit": Exits the program. In case the current RF has not been saved, the system 

prompts for a confirmation. 

Fig. 2 The Tree 
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1.4.2 "Windows" commands 

"New":       This command inserts a new rectangle into the current RF. At creation, the 
new rectangle is ready to be moved by using the mouse or the arrow keys. 
Mouse button 1 or the <ENTER> key validates its position and inserts the 
rectangle in the tree. At that time, the rectangle is also given an identifier by 
the system. 

 
"Delete":    This command deletes the current rectangle. Issuing this command makes 

the system recompute the tree and all its identifiers in respect to the new 
hierarchy. 

 
"Move":      This command moves your current rectangle inside the board space. 
  
"Size":       This command resizes your current rectangle inside the board space.  
 
 
• Note that when moving or resizing, the system drags the rectangles as it does 

ordinary windows.  
 
• Note that when moving or resizing, the "Esc" key removes the rectangle from the 

actual reference format (and from the tree). 

1.4.3 "View" commands 

"Toolbar": this command display or not the toolbar. 
 
"Scoreboard zoom": this menu allows to select the zoom factor of the "scoreboard window.  
 
Let's take an example of editing the rectangle coordinates using the keyboard: 
 
1. Select New on the Reference Formats pull-down menu to get a new RF. 
 
2. Select New on the Windows pull-down menu or press <CTRL> <INS> to get a 

rectangle. 
 
3. Drag the created rectangle, by moving the mouse, to the required position. Press left 

mouse button to validate the position. At this point, the rectangle appears in green (it 
is a window), it becomes an element of the tree and is given an identifier. Repeat 
operation 1 - 3 once to create another rectangle. 

 
4. With the keyboard you may modify any entries of the tree except the identifier which 

is given by the system. 
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To move along the entry fields of a tree element, press <TAB>/<SHIFT><TAB> to go in 
forward/backward direction. Entry fields 1 and 2 display the x and y board-coordinates and 
entry fields 3 and 4 display their sizes. If you apply any changes to these coordinates, you 
have to validate them by pressing <ENTER>. To make the selected window become a 
superimposed window, activate the checkbox at the right side of the tree by pressing the 
<SPACEBAR>. 
 
To move through the tree elements, press the arrow keys <UP> and <DOWN>. This gives 
the focus to the new active tree element and it turns yellow. 
 
Notes: 
 

• If moving along the tree elements causes some windows on the working space to 
be hidden, it does not means that they have been removed but rather the displaying 
order has been changed. 

 
• If the tree grows out of the screen because your RF contains a lot of rectangles, you 

can pass through the tree elements by pressing <PAGEDOWN> and <PAGEUP>. 
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1 INTRODUCTION – DATA HANDLING INTERFACE (DHI) 

The DHI (Data Handling Interface) is a program that receives information from serial lines 
and converts it into an image to send to the board (through the Display Director, according 
to the MAKER philosophy), 
The DHI program can be connected to any timekeeping system or computer (connected to 
a serial line) which provides information with a specific protocol. A drawing of a cabling 
diagram is shown on the following drawing (Fig. 1).  
 

Data Handling computer

Timekeeping system (

GALACTICA Computer

COM1

COM2

for example)

 
Fig. 1 

 
Two different ways are available to keep information from serial lines: the Editing one, 
which keeps files from one serial line and transfers it into the editing buffer and the Overlay 
mode, which superimposes fields to the editing area; the mode used by the program 
depends on the selected protocol. 
 
The Editing mode manipulates ASCII codes in a text oriented environment by using non-
proportional fonts and supports part of the ANSI protocol.  
 
The Editing mode may be used to manage start and result lists of several sports provided 
by a data handling computer. 
 
The Overlay mode gives a full access to the IMAGE EDITOR (IMED) and leaves the user 
to manage a complete sport using database information corresponding to the protocol of 
the timekeeping system. 
 
It is possible to mix both modes. For example, in figure 1, running time and net times are 
provided by the  and competitor names are provided by the data handling 
computer.  
 
The data handling computer fills the Editing area using the ANSI – OMEGA protocol, and 
the  fills the Overlays, because its data are sent to the DHI using a specific 
protocol which is associated with database fields. 
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That means that the scoreboard image generated by the DHI program is a multi layer 
image. The 1st layer is called “Base” layer, the 2nd layer is called “Overlay”. The “Base” 
layer (= Editing Area) could be filled by using the keyboard of the GALACTICA computer 
as a text oriented editor or by using the files received and saved into the editing buffer 
(Fig. 2).  
 
The “Overlay” layer is a user-defined layout (generated by the IMED) which could include 
some database fields of the system connected to the GALACTICA. This layer could be 
one of the overlay available in the overlays selection bar (c.f.1.1The DHI working space). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. 2 
 

        100m Men Final 
        WR: 9.79            

1 Zakari Abdul Aziz GHA  
2 Malcolm Christian GBR  
3 Montgomery Tim    USA   
4 Greene Maurice    USA   
5 Boldon Ato        TRI   
6 Williams Bernard  USA   
7 Collins Kim SKN

                      
 
                            
                             
 
 
 

         100m Men Final 
         WR: 9.79            
1 Zakari Abdul Aziz GHA  
2 Malcolm Christian GBR  
3 Montgomery Tim    USA   
4 Greene Maurice    USA   
5 Boldon Ato        TRI   
6 Williams Bernard  USA   
7 Collins Kim       SKN 
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1.1 The DHI working space 

 
 

 
Fig. 3 

 
  Main window 

 
 Connection button with Display Director (DD) 

 
 Connection button with Timekeeping system (ARES, TL5005, MTS, 

PowerTime, Scan’O’Vision, computers, etc… connected on COM 
ports), F6 button opens the serial lines. 

 
 Overlays selection bar (26 free available images (= overlays)) 

 
 Preview window (=  “Base” (Editing Area) + “Selected overlay”); the 

size of the area corresponds to the board size (in pixels).  
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1.2 Connectivity 
 
 
 
 
 
 
 
 
 
 
 

1.2.1 Display Director connection, the F5 button 

The generated image can be sent at any time to the Display Director (DD), which sends it 
to the scoreboard. 
 
The DD must request the connection (Get from Maker..., DHI). 
 
When the DD is connected, the function key F5 controls the information to be sent to the 
scoreboard, and when it is sent. 
 
The color of the button shows immediately what mode the program is in: 
 
Red Image preparation mode.  The program does not transmit the image to the 

DD. 
 
Green  Direct mode.  Any change in the image is transmitted to the DD. 

1.2.2 Timekeeping equipment connection, the F6 button 

When the interfaces have been correctly assigned, you can instruct the program to start 
reading the information coming from the selected lines.  This can be done with the 
Activate competition toggle command available under the Actions heading in the menu 
bar, or with the function key F6. 
 
The program goes into a continuous reading mode and processes all the information 
coming in through the interfaces. 
 
The color of the button shows immediately what mode the program is in: 
 
Red COM port(s) is (are) closed.  No data sent by the timing equipment is 

interpreted. 
 
Green COM port(s) is (are) opened.  All data sent by the timing equipment are 

interpreted and any changes affect the database fields. 

     
Timekeeping equipment              DHI           Display Director 

 
Fig. 4 

F6 F5 
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1.3 General Settings 

The General Settings window can be displayed by 
selecting the General Settings command in the 
Options menu. The settings are split in three tabs 
(Base, Overlays, Start options). The first tab (Base) 
is used to set the protocol that will fill the Editing 
Area. The second one, the Overlays tab, is used to 
set the protocol and database matching with the 
equipment connected on the computer (Base for 
the Editing Area, and Overlays for the overlays). 
The last one is the start options. 

1.3.1 Base tab 

In the Base tab, you can select the protocol used and set serial settings for the connection 
with the equipment that will “fill” the base data. If no system fills the Editing Area, select the 
None option for the base protocol. The properties button  shows the COM port selection 
& properties window which allows you to select and configure the serial line parameters 
(Fig. 6). 

1.3.2 Overlays tab 

In the Overlays tab, you can select the protocol used and set serial settings for the 
connection with the equipment that will “fill” the overlays data. If no system fills the 
overlays, select the None option for the Setting files path. Default option is the UNT4 
settings, that means that the equipment connected to the GALACTICA computer sends 
scoreboard information using UNT4 protocol. The dropdown list displays the last Sport 
settings used. Depending on which competition or sport you do, you can easily change the 
settings of the DHI program (protocol, overlays, database info, etc…).  
If the overlay tab is not visible, it means that the sport folder is defined in the command line 
of the program shortcut (generally done for the Water polo shortcut for example). You can 
add or remove a path in the dropdown list by using respectively the buttons  and . 
The properties button  shows the COM port selection & properties window which allows 

you to select and configure the serial line parameters (Fig. 6).  
With the setting path in command line argument (see in 
GALACTICA Basic Software - User Manuals / “How does it 
work ?” document, in chapter 1.4.4 to know how to create a 
shortcut for a specific sport), the DHI is protected against 
unfortunate manipulations and a specific shortcut like water 
polo symbol will only launch a DHI with a water polo 
configuration. The only setting available for a “protected” DHI 
is the serial line settings available in menu Options\Serial 
Interface settings…  For Overlays.  

 
A setting path has to contain at least a file with extension .PRO and another with extension 
.DBE.  

 
Fig. 5 

 
 

Fig. 6 
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1.3.3 Start options tab 

In the Start options tab, you can set the starting options of the DHI such as: 
 

 Automatically activate competition (F6) at start  
This option automatically opens the serial lines when the DHI program starts and it 
begins reading the information coming from the serial lines. The program goes into 
a continuous reading mode and processes all the information coming in through the 
interfaces. 
  

 Automatically connect Display Director (F5) at start 
By using this option, the Display Director can access the DHI generated image as 
soon as the program has started. 

 
 Automatically start in full screen mode 

By using this option, the program shows the generated image in full screen mode 
on the GALACTICA computer screen. It is strongly recommended not to use this 
mode in a standard configuration. This option should only be used for a Plasma 
display installation. 

2 THE EDITING AREA 

The Editing Area is a text oriented editor. The 
size of the area corresponds to the board size 
(in pixels). It can be filled manually as explained 
below or with a protocol via the serial line as 
explained above. 
 
To edit texts, click on the left mouse button 
inside the area. The pointer changes its shape 
and blinks in the area.  
 
Type characters to edit, Backspace or Del key 
to delete, arrow keys to move, Enter to insert a 
line (in insert mode).  
 
The Insert key toggles between insert and 
overstrike editing mode. 
 
Use the <Ctrl> Delete key to remove a line and copy it into a temporary buffer, and the 
<Ctrl> Insert key to insert the temporary buffer at the cursor position.  
 
The End key moves the cursor to the end of the text in that line, a double End to the end 
of the line and a triple End to the end of the buffer. 

 
Fig. 7 

You have to select two different serial lines if you use both Base and Overlays 
protocol, otherwise the DHI program will generate an error when opening serial lines. 

Note 
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The Home key moves the cursor to the beginning of the line, a double Home to the 
beginning of the first line. 
 
Note that the blinking cursor appears only in the DHI program and will not be displayed on 
DD and obviously not on the board. 
 
The Editing Area uses a non-proportional font which could be changed by selecting Base 
image font in the Images menu. This will display the default Fonts window with all non-
proportional fonts available on the Microsoft® Windows system. 

2.1 Color of the base image (Editing area) 
The colors used in the Editing Area for text or line 
background can be changed (as done on the first line in 
figure 7) by selecting Base image colors in the Images 
menu. This will cause the dialog Base image colors to 
become active (Fig. 8). 
 
A background and a foreground color can be selected for 
each line. Click on the arrow to select the line to be 
assigned; it is then possible to set the foreground and the 
background color for it. The number of lines displayed in 
the line field depends on the font size selected in Base 
image font. 
 
When you have made some changes, you must valid them in the Apply to group: 
 

Line to apply the selected colors to the line. 
 
Odd to apply the selected colors to all the odd lines. 
 
Even to apply the selected colors to all the even lines. 
 
All to apply the selected colors to all the lines. 

 
Press the OK button to confirm the colors modification or Cancel to abort the colors 
selection. 

 
Fig. 8 
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2.2 The Received files dialog 

The Received files dialog (Fig. 9) shows the names of the images received by the serial 
line (OMEGA - ANSI Protocol) and the time when they were sent. 
To display the Received files dialog, select File list in the View menu. 
If the Update buffer check box is crossed, the received file is transferred directly to the 
editing buffer, but it is in any case stored on the hard disk, in order to re-use it afterwards. 
The filename is part of the protocol (c.f. 5.1 ANSI – OMEGA protocol). If no image name is 
specified in the protocol, the program assigns a name such as IMG1, IMG2, ..., IMG99.  
 
To open a file from the list box, double-click on its name or select it and then press the 
View button. The file will appear in the Editing Area. The Blank button clears all the data 
displayed in the Editing Area. 
When a file has already been viewed once, a check sign ( ) appears in front of its name. 
To remove an entry in the list box, use the Del key. 
 

 

 
 

Fig. 9 
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3  OVERLAYS 

An overlay is a definition of fields defined in the rectangle of the board and it is always 
superimposed onto the Editing Area. 
 
The program manages 26 different overlays. To select the one you want to use, select it in 
the overlays selection bar (c.f.  in 1.1 The DHI working space). To remove an overlay 
and display the base only, click again on the selected overlay button. If you want to 
replace the currently displayed overlay by another one, just click on the new one button. 
 
The overlays are normally used to show the running times during the competitions, but 
there are no limits to your imagination.  
 
To add a new overlay use the Insert… function in the Images menu and enter the image 
name. To edit an overlay, use the Edit submenu in the Images menu. Those functions will 
call the Image Editor (Field Parameters Editor). 
 
The Image Editor (see the IMED chapter in the GALACTICA Basic Softwares - User 
Manuals) is specially defined to try to solve all your formatting problems and is fully open 
to the definition of the overlays. 

3.1 Automatic action 
The DHI program offers the possibility to 
transit to another overlay or to play an 
overlay sequence on reception of a specific 
message of the overlay protocol. To set 
those automatic actions, select Edit 
automatic action… in the Options menu. 
This will display the Automatic action on 
message window (Fig. 10).  
 
In figure 10, when the timekeeping 
equipment sends a General Clearing 
message, the DHI will automatically switch 
to the overlay called OMEGA, which could 
be in an advertising image.  
 
By checking the Wait XX seconds check 
box, the selected overlay will be displayed 
for XX seconds and then the DHI will 
automatically go back to the previous 
overlay. 
 
It is also possible to play an overlay 
sequence on reception of a specific 
message. When you select Play an 
overlay sequence in the Action to do field, 
the dialog box will show you the sequence 
to play (Fig. 11).  

 
Fig. 10 

 
Fig. 11 
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You can easily add, insert, move or remove overlays in the sequence. For each overlay of 
the sequence it is possible to set its duration of apparition. And finally it is possible to set 
the sequence as an infinite sequence by checking the Loop Sequence check box. 
 
In figure 11, when the timekeeping equipment sends a Daytime message, the DHI will 
automatically start the overlay sequence which will display in loop and step by step the 
Welcome, Daytime, Timetable and OMEGA overlay using the matching duration defined 
for each overlay. 
 
Those automatic actions are really useful; if their settings are well done, it is not necessary 
to have an operator on the GALACTICA computer during the competition. By this way, it 
prevents all wrong display of information on the board and the GALACTICA DHI will be 
perfectly synchronized with the timekeeping equipment. In a team sport for example, when 
one of the teams scores, the DHI switches instantaneously to the overlay that will display 
the word "GOAL" on the full size board.  
 
 
 
 
 

3.2 Overlay management 
In the Images menu, all features to manage the overlays are provided. The Insert 
command will ask you to enter a name for the new overlay and then it will start the Image 
Editor (IMED). The Edit popup menu allows you to edit one of the existing images by 
starting the IMED with the selected image. The Rename command allows you to change 
the name of an overlay. The Change order command can help sorting the overlays in the 
overlays selection bar. The Import command is really useful if you want to have two 
similar overlays. In Water polo for example, you have an “In match” image containing all 
the match information like teams’ name, score, players’ name, number and faults, 
penalties and running time. When a team scores a goal, you can replace the image with 
the players' name and number by the word “GOAL” (Fig. 12).  

 

The Actions \ Automatic Action menu enables or disables this feature. It has to be 
checked to allow the DHI to manage itself the competition. 

Note 

“In Match” image       “GOAL” image 
Fig. 12 
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The easiest way to do that is to use the Import function. Imagine that the “In Match” image 
is the second one in the overlays selection bar. To prepare the “GOAL” image, select 
Import in the Images menu: the Import a Galactica image file window opens; then you 
must select Custom_1.igf (note that all button images are saved with a name 
Custom_XX where XX is a 0 based index of the button position), so in our case 
Custom_1.igf corresponds to the second image in the overlays selection bar. This will 
add a new button called “In Match”. Launch the Rename function and rename the last 
image as “GOAL”. Then you can edit the “GOAL” image using the Edit function, and with 
the IMED, delete all the players’ name, number and faults. Finally add a Free Text field 
“GOAL” which covers the players’ surface as shown on figure 12. By this way all the other 
fields like teams’ name, score, running time, etc…, stay at the same place. 
 
The Remove function removes an overlay in the overlay list and its associated button in 
the overlays selection bar. By security, a copy of the overlay which has been deleted is 
saved with the file extension .~gf in the current sport folder.  
 
 
 
 
 
 
 
 
 
 
The function Transition effect for image , in the Images menu, lets you to define the 
transition effect that will be used when the image is selected. The result of the effect will 
only be shown on View online in Display Director (DD) when F5 is activate, and the DHI is 
selected in the DD. Detail and explanation about effect could be found in DD user manual. 

4 VIEWING OPTIONS 

In the View menu, you can select the Zoom factor of the preview window between 33% 
and 300%. 
 
The full screen mode will stretch the preview window with the generated image to the 
whole screen.  
The Full Screen command is a toggle, you can switch from one mode to the other just by 
pressing the Esc key. It is strongly recommended not to use this mode in a standard 
configuration. This option should only be used for a Plasma display installation. When you 
set the Full Screen mode, the cursor is moved out of the screen. 
 
The last available option of this menu is File list, which shows or hides the Receiving files 
dialog (c.f. 2.2 The Received files dialog). This menu should only be used to show this 
window if a base protocol is set, otherwise it is better to hide this window. 

If, by accident, you delete an overlay and want to restore it, you can do it by using the 
Import function and by changing the type in the Import a Galatica image file window to 
Galactica Old Custom Files (*.~gf). The deleted overlays will be displayed. 
Note that if you delete twice the same “button”, only the last one will have been saved 
and will have overwritten the secure copy of the previous one. 

Note 
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5 BASE PROTOCOLS 

5.1 ANSI – OMEGA protocol 
The ANSI - OMEGA is the main protocol used to send layout. This protocol will 
acknowledge each received file, extract the filename, decode the ANSI colors sequences 
and accept the command to select an Overlay and to show/hide the overlay. 
 
Communication protocol 
 
<SOH>IMAGE_NAME=[Image Name]<CR><LF>[Text]<EOT>  
 
 
Image Name 
 
The Image Name is the name used to identify the actual working buffer. 
It can be up to 8 characters (DOS format of a filename). 
 
Example: MLOJF1A (Long jump men, first round, heat 1, page A). 
 
 
Text 
 
The text is a sequence of lines of ASCII characters, each one separated by <CR><LF>. 
 
Example: line 1<CR><LF>line 2<CR><LF> ... <CR><LF>last line 
 
 
Overlay selection  
 
Index is 0 based. Note that in the GALACTICA OS/2 version, the index was 1 based and 
maximum was 10. 
 
<SOH>OVERLAY [0..25]<EOT>  
 
Example: <SOH>OVERLAY 3<EOT> 
 
 
Overlay ON/OFF 
 
<SOH>OVERLAY [ON/OFF]<EOT>  
 
Example: <SOH>OVERLAY ON<EOT> 
 



Galactica - Data Handling Interface 
 
 

 
3311.544.02 Version 1.1 Page 13 

5.2 Swiss Timing Interface - Mode 1 

Shows a text 
 
<SOH><STX><DLE>xxyy[Text]<EOT>  
 
xx is the column and yy is the line to position the text. 
 
Erase from position xxyy to the end of the line 
 
<SOH><STX><DLE>xxyy<ERL><EOT>  
 
Erase the image 
 
<SOH><STX><ERP><EOT>  

5.3 Control Characters 
 
<SOH> hex 01  start of header 
<EOT> hex 04  end of text 
<CR>  hex 0D  carriage return 
<LF>  hex 0A  line feed 
<ERL> hex 0B  erase line 
<ERP> hex 0C  erase page 
<STX> hex 02  start of text 
<DLE> hex 10  data link escape 
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1 INTRODUCTION – HOW DOES IT WORK ? 

1.1 General 

Galactica is a software suite that manages a full matrix display board. Galactica contains 
background programs that control the hardware that drives the board, and interactive 
programs to give complete control over the presentation of data and images. The central 
program is the Display Director, through which all images to be displayed on the board are 
coordinated.  
 
Sport specific programs can also be added to the suite. These programs are known as 
‘Makers’ as they make an image, often in real time, and sent it to the Display Director to be 
displayed. An example is the swimming program, which can receive information from the 
timing system and integrate it with race titles and swimmers names to ‘make’ a single 
image on the board.   
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1.2 The principle 
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Programs 

1.3 Base programs 

1.3.1 Display Director (DD) 

Display Director is the main program of Galactica. It must be started to send an image to 
the display board. It is also the main user interface. With it you can select and position 
images you want to send to the display board (also images built by a Maker), add effects 
to the images, and preview images before displaying them on the board. A powerful 
recording tool allows the creation of dazzling sequences of images that can easily be 
configured and left to loop continuously. 

1.3.2 Scoreboard Interface (SCBI) 

This is normally a background program, receiving images from the DPCT and sending it to 
the scoreboard.  
 
It can be opened by selecting “Scoreboard settings” through the Display Director menu or 
toolbar. The functions available in this dialog depend on the type of display board 
connected. Typically brightness and contrast of the board can be modified from here.  
 
This program will also generate informative error messages if Galactica cannot 
communicate correctly with the board.  

1.3.3 Display Controller (DPCT) 

DPCT is a background program, which automatically starts when Windows starts. When 
Windows is running you can see the DPCT icon in the “tray bar” (fig. 2).  
 
 
 
 
 
 
This program is the heart of the system. It has to be running before you start any other 
program in the Galactica Suite. As shown on figure 1, it is the interface between Makers 
and DD, and between DD and SCBI.  
This program can only work if the correct dongle (hardware key) is plugged into the 
parallel port or USB of your computer.  

 
 

Fig. 2 
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1.4 Makers 

1.4.1 General 

All makers generate .IGF files, those files define the position of each field in an image. 
Those files are generated by the Field Parameters Editor, available in the menu from all of 
the following makers. 

1.4.2 Timer 

This program allows you to display daytime and date on the scoreboard. It makes an 
image (that user can easily edit) that can be displayed by the DD. 
With this program it is also possible to display a countdown. 
If the Galactica computer is connected to DCF receiver, this program will use the correct 
time coming from the antenna, otherwise the computer date and time will be used. 
 
Warning: If you don’t use a DCF receiver, before showing date and time on the 

scoreboard, be sure that your computer is set at the correct time. The 
program allows you to set the date and time internally. 

1.4.3 Swimming 

This program is a specific interface for managing of a swimming event. It can work in 
automatic mode, receiving names and times from the ARES, or it can manage all the 
competition with swimmers’ names and using only times coming from the ARES system.  
The setup files of this program are generally located in <GALACTICA 
folder>\PRM\Swimming. In this folder there is a .PRO file and a .DBE file. Those files 
define respectively the protocol, and the database entries information. Those files are 
configured in factory by Swiss Timing Ltd. By default there are already the .IGF files for the 
start list (SW_START LIST.IGF), the result list (SW_RESULTS.IGF), the summary list 
(SW_SUMMARY.IGF) and the podium (SW_PODIUM.IGF). You can add 14 personal 
images. 
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1.4.4 Data Handling (DHI) 

This program is the general interface for managing all competitions which are managed by 
an external system like ARES, Scan’O’Vison, PowerTime, MTS, TL5005, etc… This 
program is based on two files. One .PRO file and one  .DBE file. Those files define 
respectively the protocol, and the database entries information. Those files work really 
closely together, because the .PRO file describes the data in the protocol, the COM port to 
connect and where those data have to be saved in database. The database fields are 
defined by the .DBE file. Database entries are visible in Field Parameters Editor when you 
define a field with data coming from database. 
You can use DHI for many sports and many timekeeping systems, so it is strongly 
recommended to save .PRO, and .DBE files of each sport in separate directories in PRM 
directory. The menu Set Files path allows you to quickly switch sport or configuration by 
using different sets of .PRO and .DBE files. 
If you use both Diving and Water polo for example, we recommend that you create a new 
shortcut in Windows Start menu with each directory path on the command line and a new 
icon (Fig. 3).   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1.4.5 Football 

This program is a specific interface for managing football championships. With it you can 
follow a whole championship with ranking. You can also display statistics (Goals, Scorers, 
Ball possession for each team, etc...). Setting files of this program are generally located in 
<GALACTICA folder>\PRM\Football. Team information is generally located in 
C:\Football Teams.  
For more information please have a look in the Football user manual. 

 
 

Fig. 3 
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1.5 Utilities 

1.5.1 Window Format Editor (WFED) 

This program allows you to define and edit reference formats for Display Director. A 
Reference format is a group of one ore more windows which can be used to divide the 
display area into different regions that can be independently controlled. Each window can 
contain an image, or a maker image, with effects and/or a frame. It generates the .ACT file 
located in PRM directory. 

1.5.2 Text Editor 

This editor is useful to create editable images that contain only text information. It 
generates a .GTX file that the Display Director handles like an image. 
  
Tip: Save your text file in the same directory as your images directory. Generally 

<GALACTICA folder>\img. 

1.5.3 Paint Shop Pro 

This program is provided with Galactica Suite "Full version", it is a standard graphic editor 
from graphics experts, JASC. It is really easy to use, and it will be really useful for users 
who want to convert color images to black and white images, or to resize images, 
downloaded from the Web for example, to fit the display board size. Further information 
can be found at www.jasc.com. 

1.5.4 Animation Shop 

This program is provided with Galactica Suite "Full version"". It is a standard animation 
editor from graphics experts, JASC. You can edit and create your own .AVI and .GIF 
animations that can then be used by Galactica Display Director. 
Further information can be found at www.jasc.com. 
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